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Walk-Through

3333project
Animated Internet Ads

Your client wants to create a series 

of ads to place on Web sites that 

are used by existing and potential 

customers. � ey have asked you 

to create a short animation rather 

than just a static image, in hopes of 

attracting more attention when the 

ad appears in a browser with other 

content.

� is project incorporates the following skills:

� Creating shape tweens to animate changes in shape and color

� Creating classic tweens to animate changes in position and opacity

� Adding text to a Flash movie

� Adapting � le content to match di� erent � le dimensions

� Using a Flash project to manage assets for multiple � les

� Publishing a � le to SWF for distribution
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Project Meeting
We’ve provided you with our logo and an 
image that we want to use in the ads. Since 
these are going to be placed into a variety of 
Web sites, we want some kind of animation 
that might help catch a user’s eye.

Most of the sites where we’re planning on 
advertising use standard ad sizes. I’m not sure 
exactly which sizes we’re going to purchase, 
but we do like the rectangle and square shapes 
better than the narrow banners. 

We might decide on some of the other options 
later, but we’d like to get started with three 
common sizes:

• 300 � 250 pixels

• 336 � 280 pixels

• 250 � 250 pixels

Flash includes prede� ned templates for most of 
the common ad sizes, so that’s the easiest way 
to start the � rst � le.

I want you to animate di� erent aspects of the 
client’s logo over the course of the animation. 
� e kayaker is ideally suited to move across the 
stage. He should paddle across the stage while 
the sun rises. Halfway through, he should 
pause and wait until the tagline appears, then 
move the rest of the way across while the image 
gradually appears in place of the sunrise.

After you create the initial ad, you can use 
several built-in techniques to repurpose the 
content for other sizes. You should also take 
advantage of the Project panel to manage assets 
that will be used in more than one � le, so it 
will be easier to make universal changes in any 
of the shared assets.

To complete this project, you will: 

� Create a � le based on a template

� Create a shape tween

� Tween an object’s color

� Create a classic tween

� Tween an object’s opacity

� Stop the animation timeline

� Create and control a text object

� De� ne font embedding

� Control object stacking order

� Create a Flash project

� Scale content to document properties

� Edit a shared symbol

� Publish � les to SWF
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Project 2: Talking Kiosk Interface

Stage 3	 Creating	Frame	Animations

The basic underlying premise of animation is that objects change over time — from complex 

transitions in color, shape, and opacity to moving a character to a new position. The most basic type 

of animation is to simply replace one object with another at specific points in time; you will create this 

type of animation in this stage of the kiosk project to make it seem like the girl is talking.

Repositioning or replacing objects on successive frames results in the appearance 

of movement when you watch an animation; in reality, your brain is being fooled — 

you’re simply seeing a series of images flash before your eyes (hence the application’s 

name). Your brain thinks it’s seeing movement, when in fact it’s simply processing a 

series of still images displayed in rapid succession.

To make an animation appear to run continuously, you can loop it so it starts 

over at Frame 1 after reaching the last frame. (In fact, as you will see, looping is the 

default state of an animation; you have to use code to prevent the timeline from 

automatically looping in the exported file.)

To create animation, you need to understand several terms and concepts:

•	 The	Flash	Timeline panel shows a visual depiction of the passage of time. 

Each fraction of a second is represented by a frame (the rectangles to the right 

of the layer names). The playhead indicates the current point in time, or the 

frame that is visible on the Stage.

•	 The	number	of	frames	in	one	second	(ca
lled	frames per second, FPS, or 

frame rate) determines the length and quality of the overall animation. New 

Flash files default to 24 fps, which is the standard frame rate of most film movies in the United 

States (although HD formats range as high as 120 fps). Animations only for the Web are 

commonly developed at 15 fps.

•	 A	keyframe indicates the point in time at which something changes. If you want to change 

something, you need to insert a keyframe at the appropriate moment on the timeline.

•	 Regular	frames	between	keyfram
es	have	the	same	content	as	the	pre

ceding	keyframe.

Add StreAming Sound

Unlike the event sounds that you used in the previous exercises, stream sounds play 

as soon as enough data is downloaded (called progressive downloading) to the user’s 

computer. Stream sounds cannot be saved on a user’s computer; the sound file must be 

redownloaded every time it is played. Stream sounds are linked to the timeline, which 

means they stop playing if the timeline stops (i.e., they are “timeline dependent”). 

 1. With atrium_kiosk.fla open, add a new layer named Talking immediately 

above the Mouths layer.
The empty circle indicates 

that no content currently 

resides on the keyframe.

By default, the first frame 

of every layer is a keyframe.

The filled circle indicates 

that some content exists 

on the keyframe.

 2. Select the Frame 1 keyframe of the Talking layer.

The term playhead is 

a throwback to the days 

when animation and 

video were shown on 

physical tape-reading 

machines. The playhead 

is the component under 

which the tape moves, 

and the tape is read by 

the player. By sliding 

the tape back and forth 

underneath the playhead, 

an animator could make 

a movie run forward and 

backward. 

Note:

Because stream sounds 

are typically larger files 

(longer sounds equal 

more data and larger file 

size), the quality of these 

sounds might be poor 

for users who have slow 

Internet connections. 

Note:

95Project 2: Talking Kiosk Interface

Organize YOur LibrarY with FOLders

Library folders work the same as layer folders; they help you organize and structure 
complex files. Movies often contain dozens or even hundreds of assets — and the 
more complex a movie becomes, the more useful it is to clearly organize those assets. 
Although this step isn’t strictly necessary, it is always a good idea to organize your work 
so you can more easily organize your thoughts and processes going forward.

 1. With atrium_kiosk.fla open, expand the interface.ai folder in the  
Library panel.

 2. Click the Illustrator Symbols folder (inside the interface.ai folder) and drag 
down to the empty area at the bottom of the panel.

This moves the Illustrator Symbols folder to the first level of the library. The symbols, 
which are placed on the Stage, are not affected by the move.

Drag the Illustrator 
Symbols folder to the 
empty area at the bottom 
of the panel to move it out 
of the interface.ai folder.

Click a column 
heading to sort 
library items by 
that category.

The highlight shows that 
the folder will be moved to 
the first level of the panel.

 3. Double-click the Illustrator Symbols folder name to highlight the name. 
Type buttons to change the folder name.

 4. Click the start_over button symbol icon and drag it into the Buttons folder.

 5. Double-click the interface.ai folder name to highlight the name. Type 
component artwork to change the folder name.

If your Library panel 
is too short to show an 
empty area below the 
current assets, Control/
right-click any of the 
existing first-level assets 
and choose Paste. The 
pasted symbols are pasted 
at the same level as the 
asset where you Control/
right-click.

Note:

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Visual Explanations
Wherever possible, screen 
shots are annotated so you 
can quickly identify important 
information.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.
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Project 2: Talking Kiosk Interface

Project Review

 1. Briefl y describe at least three uses of the Library panel.

 2. Briefl y explain the difference between event sounds and stream sounds.

 3. Briefl y explain the concept of lip syncing, as it relates to symbols and the Flash timeline.

 1. In a Button symbol, the _______________ 

defi nes the area where a user can click to 

trigger the button.

 2. _______________ to edit a symbol in place on 

the Stage.

 3. The _______________ marks the location 

of the defi ned X and Y values of a placed 

instance.

 4. A(n) _______________ defi nes the point in 

time when a change occurs.

 5. _______________ is the number of animation 

frames that occur in a second.

 6. _______________ sounds are timeline 

independent; they must download completely 

before they play. 

 7. _______________ sounds are timeline 

dependent; they play as soon as enough of the 

data has downloaded to the user’s computer. 

 8. The _______________ sync method prevents 

more than one instance of the same sound 

from playing at the same time.

 9. You can use the _______________ dialog box 

to change the length of a specifi c sound fi le.

 10. Use the _______________ option to replace 

one symbol with another at a specifi c frame.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your own design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of your reasoning behind your fi nal design.

Portfolio Builder Project

We want to build a new introduction page to 
our video game site. We’re using a robot avatar 
throughout the video game site, and want that 
character to be featured on the intro page — I even 
recorded the intro message with a “mechanical” 
sounding voice. (Feel free to re-record the audio if 
you want to, as long as the message stays the same.)

I found a robot illustration that I like, but I’m not 
an artist; I’d be happy to review other artwork if 
you have a better idea. I also want you to develop 
some kind of background artwork that makes the 
piece look like a cohesive user interface. 

You need to include two buttons: one that links 
to online technical support and one that links to a 
telephone support page. 

In the � nal � le, I want the robot to look like it’s 
talking, but I also want the robot to point to the 
related buttons when the appropriate part of the 
intro sound plays. 

Your client is a company that provides 
technical support for children’s online video 
games. � e owner wants an introduc tion page 
for that site similar to the kiosk interface, with 
a talking character that identi� es the options.

To complete this project, you should:

� Download the client’s supplied � les in the 
FL6_PB_Project2.zip archive on the 
Student Files Web page.

� Review the client-supplied sound and 
artwork � les.

� Develop a site intro page with a talking 
robot and two di� erent buttons. 

� If you use the client’s artwork, import the 
� le into Flash and create movie clips as 
necessary from the di� erent elements.

� If you don’t use the supplied � le, create or 
� nd artwork as appropriate.

Project Summary
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Project 3: Animated Internet Ads

� e ability to control object shape and movement is one of the most important functions in designing 

animations. In this project, you used a number of basic techniques for animating object properties, 

including size, color, and position. As you complete the next projects in this book, you will expand 

on the knowledge from this chapter, learning new ways to animate multiple properties at once. � e 

skills and knowledge from this project, however, apply to any animation — understanding frame rate, 

keyframes, and timeline independence are essential to being a successful animator.
� is project also introduced the concept of adding text to a movie. Many Flash projects will 

involve some text, even if that text is eventually converted into drawing objects; you now know how to 

create and format text to communicate a client’s message directly within a Flash � le.
Finally, you learned techniques for creating multiple variations of the same � le, using built-in 

tools to automate as much of the work as possible. � ese techniques and skills can be helpful whenever 

you need multiple versions of a single � le — whether you need to create multiple di� erent-sized ads or 

di� erent versions for various mobile device sizes.

Create a shape tween to animate a change 
in object color

Use keyframes to control 
animation timing

Create a shape tween to animate a change 
in object size

Create a classic tween to animate a change in 
object position

Create a classic tween to animate a change in object opacity

Use blank keyframes to prevent an object from appearing too early

Place and format text 
on the Flash Stage

Define font embedding 
for an SWF file

Scale and adjust content to match different file dimensions

Use a project to manage assets for multiple files

47
Project 1: Corvette Artwork

Free Transform mode allows you to change an object 

(or group) on the Stage by simply dragging. You can enter 

Free Transform mode by selecting an object with the Free 

Transform tool, by pressing Q (the keyboard shortcut for the 

tool), or by choosing Modify>Transform>Free Transform.

In Free Transform mode, the selected object is surrounded 

by a black bounding box with heavy black handles. A hollow 

circle in the center indicates the object’s transformation 

point. Depending on where you place the cursor, you can 

apply different kinds of transformations. The cursor icon 

changes to reflect the change you will make by dragging. 
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Using the Free Transform Tool

Press Command/Control while 

dragging a corner handle to distort 

the object shape.

Press Command/Control while dragging 

a side handle to skew and resize an object 

at the same time.

Click a corner handle and 

drag to resize both height 

and width at once.

Click a side handle and drag to resize the 

object’s height (left) or width (right).

Click and drag between handles on 

any side to skew the object.

Transformations such as rotation and skewing apply 

around the transformation point, 

which defaults to the center of the object.

Moving the transformation point (left) changes the fixed 

point around which the rotation applies (right).

Click outside a corner handle 

and drag to rotate the object.

Press Option/Alt while dragging a handle to apply 

a change around the transformation point. (In this 

example, Option/Alt-dragging the bottom handle 

also moves the top handle.)
Press Shift while dragging a corner 

handle to maintain the original 

height-to-width ratio in the resized 

object (called “constraining”).

20 Project 1: Corvette Artwork

 4. In the General tab, make sure the first option — ActionScript 3.0 — is 
selected in the list, leave all other options at the default settings, and then 
click OK.

When you create a new file, the Stage is automatically centered in the document 
window. The Stage is essentially the workpace, or the digital “page” area; anything 
outside the Stage area will not be visible in the exported movie (although it will increase 
the file size, which affects its download time).

 5. Choose File>Save.

Because this is a new file that has not yet been saved, choosing the Save command 
automatically opens the Save dialog box, where you define the file name, save location, 
and format. 

If a file has already been saved at some point, the Save command simply overwrites the 
previously saved version of the file. If you want to save the new version and maintain the 
original, you have to use the File>Save As command to define a new name and create a 
copy of the file.

 6. In the resulting dialog box, navigate to your WIP>Car folder. 

 7. Change the file name to corvette.fla. Make sure Flash CS6 Document is 
selected in the Format/Save As Type menu and click Save.

Native Flash files use the FLA extension. By default, the extension is included in the 
Save As/File Name field. You don’t need to type it again if you don’t delete the default 
extension from the field.

If necessary, you can use 
this menu to save a file to 
be compatible with the 
previous version of Flash.

 8. Continue to the next exercise.

We have arranged our 
workspace to make 
the best possible use 
of space in our screen 
shots, including two 
docked and collapsed 
panels that we will 
expand when necessary. 
Feel free to arrange the 
panels however you 
prefer; for this project, 
you will be using the 
Tools, Properties, Align, 
Timeline, and Color 
panels.

Note:

Press Command/
Control-S to save the 
active file.

Press Command/Control-
Shift-S to use the Save As 
option.

Note:

Flash Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Visual Summary
Using an annotated version of the 

finished project, you can quickly  
identify the skills used to complete 

different aspects of the job.

Project Review
After completing each project, you  
can complete these fill-in-the-blank and 
short-answer questions to test your under-
standing of the concepts in the project.

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing you to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.
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o Working with Symbols
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 1 Corvette Artwork

o Setting up the Workspace

o Drawing in Flash 

o Painting and Coloring Objects

Th e Against Th e Clock Portfolio Series teaches graphic 
design software tools and techniques entirely within 
the framework of real-world projects; we introduce and 
explain skills where they would naturally fall into a real 
project workfl ow. 

Th e project-based approach in Th e Professional 
Portfolio Series allows you to get in depth with the 
software beginning in Project 1 — you don’t have to read 
several chapters of introductory material before you can 
start creating fi nished artwork. 

Our approach also prevents “topic tedium” — in 
other words, we don’t require you to read pages and pages 
of information about text (for example); instead, we 
explain text tools and options as part of a larger project 
(in this case, as static text in a series of Internet ads and as 
dynamic text in an interactive game). 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
fi le to saving the fi nished piece. Wherever logical, we also 
off er practical advice and tips about underlying concepts 
and graphic design practices that will benefi t students as 
they enter the job market.

Th e projects in this book refl ect a range of diff erent 
types of Flash jobs, from animating creatures in the 
ocean to programming an interactive Web site interface. 
When you fi nish the eight projects in this book (and 
the accompanying Portfolio Builder exercises), you will 
have a substantial body of work that should impress any 
potential employer.

Th e eight Flash CS6 projects are described briefl y 
here; more detail is provided in the full table of contents 
(beginning on Page viii).

Projects at a Glance



vii

Our goal in this book is to familiarize you with the Flash 
tool set so you can be more productive and more marketable 
in your career as a graphic designer.

It is important to keep in mind that Flash is an 
extremely versatile and powerful application. The sheer 
volume of available tools, panels, and features can seem 
intimidating when you first look at the software interface. 
Most of these tools, however, are fairly simple to use with a 
bit of background information and a little practice. 

Wherever necessary, we explain the underlying concepts 
and terms that are required for understanding the software. 
We are confident that these projects provide the practice you 
need to be able to create sophisticated artwork by the end of 
the very first project.
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 8 Photo Portfolio Interface

o	 Building Site 
Navigation

o	 Loading External 
Content
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 7 Travel Video Module

o	 Encoding Video for Flash

o	 Working with Components
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 6 Gopher Golf Game

o	 Preparing Game Artwork

o	 Programming Interactivity

o	 Creating a Mobile App
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 5 Gator Race Game

o	 Preparing for ActionScript 

o	 Working with ActionScript 3

o	 Creating Custom Functions

o	 Working with Variables and Arrays

o	 Scripting 
Loops

o	 Adding 
Sound with 
ActionScript
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 4 Ocean Animation

o	 Importing Bitmaps and Symbols

o	 Animating Symbols

o	 Programming Basic Timeline Control
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Getting Started
 PrereQUisiTes

Th e entire Portfolio Series is based on the assumption that you have a basic understanding of how to 
use your computer. You should know how to use your mouse to point, click, and drag items around the 
screen. You should be able to resize and arrange windows on your desktop to maximize your available 
space. You should know how to access drop-down menus, and understand how check boxes and radio 
buttons work. It also doesn’t hurt to have a good understanding of how your operating system organizes 
fi les and folders, and how to navigate your way around them. If you’re familiar with these fundamental 
skills, then you know all that’s necessary to use the Portfolio Series. 

resoUrce files

All of the fi les you need to complete the projects in this book — except, of course, the Flash application 
fi les — are on the Student Files Web page at www.againsttheclock.com. See the inside back cover of this 
book for access information.

Each archive (ZIP) fi le is named according to the related project (e.g., FL6_RF_Project1.zip). At the 
beginning of each project, you must download the archive fi le for that project and expand that archive to 
access the resource fi les that you need to complete the exercises. Detailed instructions for this process are 
included in the Interface chapter.

Files required for the related Portfolio Builder exercises at the end of each project are also available on the 
Student Files Web page; these archives are also named by project (e.g., FL6_PB_Project1.zip).

sYsTem reQUiremenTs

As software technology continues to mature, the diff erences in functionality from one platform 
to another continue to diminish. Th e Portfolio Series was designed to work on both Macintosh 
or Windows computers; where diff erences exist from one platform to another, we include specifi c 
instructions relative to each platform. 

One issue that remains diff erent from Macintosh to Windows is the use of diff erent modifi er keys 
(Control, Shift, etc.) to accomplish the same task. When we present key commands or other system-
specifi c instructions, we always follow the same Macintosh/Windows format — Macintosh commands 
are listed fi rst, then a slash, followed by the Windows command. 

Minimum System Requirements for Adobe Flash CS6:

Windows

•  Intel® Pentium® 4 or AMD Athlon® 64 processor

•  Microsoft® Windows® XP with Service Pack 3 or 
Windows 7

•  2GB of RAM (3GB recommended)

•  3.5GB of available hard-disk space for installation; 
additional free space required during installation 
(cannot install on removable fl ash storage devices)

•  1024�768 display (1280�800 recommended)

•  Java™ Runtime Environment 1.6 (included)

•  DVD-ROM drive

•  QuickTime 7.6.6 software required for multimedia 
features

•  Some features in Adobe Bridge rely on a DirectX 9–
capable graphics card with at least 64MB of VRAM

Mac OS

•  Multicore Intel processor

•  Mac OS X v10.6 or v10.7

•  2GB of RAM (3GB recommended)

•  4GB of available hard-disk space for installation; 
additional free space required during installation 
(cannot install on a volume that uses a case-sensitive fi le 
system or on removable fl ash storage devices)

•  1024�768 display (1280�800 recommended)

•  Java Runtime Environment 1.6

•  DVD-ROM drive

•  QuickTime 7.6.6 software required for multimedia 
features
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